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February’s Meeting
At our
February
meeting, Print
Explosion by
Nova Development was
demonstrated
by Bernie
Flicker.
Attendees
immediately saw how easily and quickly firsttime publishers (as well as accomplished
designers) can create great looking projects
that include unique graphics and stylish
formats – with the added benefit of many
interesting text features.
Explosion is a fitting name for a program
that offers 4,000 available designs including
greeting cards, signs, posters, banners,
certificates, calendars, labels, letterheads,
envelopes, business cards, fax cover sheets
and crafts. For example, the greeting cards
category contains 27 different types of
greeting cards with more than 2,000
completely editable designs. Business users
will find matching sets of letterheads,
envelopes, fax sheets, and business cards along
with Avery compatible Labels.
Designed with the Mac in mind, Print
Explosion will make users feel right at home.
If nothing else, it’s well worth the price of
$39 for the 50,000 graphics and 500 True Type
fonts shown in the 500-page printed catalog.
Like a dictionary, it’s a useful tool for any
family to have around. 0
Photos of the February Meeting by SmilePhoto. Thanks, Sherree!
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Bernie

Pay your dues. No increases in 2000.
Your LIMac Executive Board has voted to
maintain dues for the coming year 2000 at the
current rate of $26 per year. Dues collection
for the year has begun. Please bring your
check for $26 to the March meeting (made
payable to LIMac). 0

March’s Meeting
Digital video is the topic for the March 10
General Meeting presentation by Alliance
Computer. 7 p.m. at Anna Rubin Hall
(Building 300) at NYIT.
C.W.POST SCIENCE EXPO will take place on
Sunday, April 9th, from one to five p.m.

The upcoming expo will be an omnibus
science, health sciences and technology
extravaganza geared toward stimulating a
broader interest in and expanding public
knowledge of the physical and biological
sciences, environmental issues, natural history,
and technological advances including those
relating to computers and computer graphics.
More than eighty exhibitors and/or
presenters will be participating representing
many prestigious institutions and
organizations.
Computerized Anatomy
An interactive multimedia presentation of
human anatomy will be presented using
interactive anatomy from A.D.A.M. software
running on one of Apple’s new G3 Macintosh
computers. Questions about the Mac will also
be answered by LIMac representatives. This is
a wonderful, interactive science expo for those
who would like to attend with their families.
LIMac is looking for its members who
can spend an hour or two in our booth.
Knowledge of anatomy, biology or science is
not required. If you are interested, call Bill
Medlow at 938-9662. 0
The Internet SIG: Due to SIG Leader Al Choy’s recent injury, there will be no
Internet SIG meetings until further notice. E-mail him a get-well!
SIGs immediately after the general meeting:
Beginners SIG: Geoff compares paint and draw in AppleWorks.
Mac Help SIG: The heroic Dichter/McAteer team in action – again.
DTP/Photoshop SIG: “The web page you always wanted.” Members should
bring in examples of their work (on a floppy disk) to show the group.
Business SIG: Make it your business
to attend!
Mutimedia SIG: QuickTime reviewed.
x LIMac meetings, unless otherwise
noted, are held in Building 300 at the
New York Institute of Technology on
Northern Blvd. in Old Westbury.
| To see if school is open in bad
weather, call 686-7789.
| The next LIMac board meeting
will be at the Plainedge Library
( 931-3907) on Wednesday,
March 15, at 8 p.m.
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Aladdin FlashBack
A Review by Mo Lebowitz
We were surprised to receive a copy of Aladdin
System’s FlashBack as a prize for our recent User
Group Award for the FORUM. After installation and
use, it proves to be a pretty straightforward and
safe method of protecting work in the Finder’s
background – adding unlimited undos to any
program that allows a Save.
Here’s how it works: Drag-and-drop a file
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into the FlashBack window or on top of the
FlashBack Icon. Any file – from any application
that allows you to save your work. Set the
number and the method of file revisions you
want to archive. That’s just about everything!
Once done, FlashBack protects your file as
a real copy, and collects subsequent changes
as revision copies. Using its differencing
engine, FlashBack compares the two files and
precisely records any differences between the

President’s Message

Bill Medlow
President
ArchBill@aol.com

TIP!
Speed up Quark:
Turn on Greek
Pictures. (Document
Preferences > General
tab). This causes all
pictures to be
displayed as a gray
box until you click on
one to select it. The
gray boxes allow faster
screen redraw, which
means faster scrolling
through pages —
especially if they
contain a lot of
pictures.
Increase the point
size at which
QuarkXPress greeks
text. (Greek Below,
found in Document
Preferences > General
tab). This causes text
below the specified
point size (which is
relative to the View
percentage) to be
displayed as gray bars
instead of actual
lettershapes. This
also speeds up screen
redraw and scrolling.
Turn on Speed Scroll.
(Application
Preferences >
Inter–active tab),
and adjust the speed
slider toward the fast
end.
Conversely, turn off
Live Scroll (same
place) screen.

two. It then time and date stamps and stores
it with the other versions saved before. These
files, called diff files, are usually two to five
per cent the size of the original file and
contain every single change between versions.
So, many versions can be saved and still take
up less room than hitting Save As just a
couple of times.
Up to 999 revisions can be saved, either
by saving when you save in the program or

Technical Corner

| Why can’t I figure out how to correctly
make a startup screen using Graphic
Converter or ColorIt?
I usually use Adobe Photoshop, but I tried it
with GraphicConverter and it worked for me.
When creating the image, make sure it is 72
ppi at the same resolution as your monitor
and at the same bit depth you normally use.
For me that’s millions of colors and 1152
by 870 resolution. Save the file in Startup
Screen format in GraphicConverter’s Save As
window. Do not use compression and click
the Set Format from Extension check box. The
file will automatically be named StartupScreen,
and you must save it loose in your System
Folder. Maybe you need an updated and
registered copy of GraphicConverter. It is now
up to version 3.8. When creating your Startup
Screen, I suggest you keep the bottom 40
Italic vs. just plain tilted type
pixels clear of distractions, so you can still
There is italic type, there is true oblique type,
clearly
see your startup icons.
and there is tilted type. Any type that is
|
AOL
offers advice on setting up TCP/IP
straight up and down is called roman, whether
for
AOL
and Mac OS 9.
it’s serif or sans serif.
Judith Whetter encountered a problem with
When a designer creates an italic typeface,
AOL and both of her new Macs (an iMac
a true italic, it’s not just by tilting the roman
and an iBook, running Mac OS 9). She writes:
face. A true-drawn italic has been beautifully
“On
both computers, I noticed a warning that
crafted to match the roman – each character
would appear at every startup regarding the
has been completely redesigned from scratch.
This is fairly typical of serif typefaces, especially need to set up TCP properly for AOL use.
The warning went away on the iBook after I
classic ones.
removed AOL and its Extensions. As for the
Sans serif roman faces, though, usually
iMac DV, I noticed that certain TCP functions
have a matching italic face that is simply
(such
as web access) would often fail partially
oblique (slanted, generally at 12 degrees), not
or
completely
while using AOL. This would be
truly italic.
fixed
if
I
went
to TCP/IP Control Panel and
In a good-quality typeface, the designer
reset the settings, but the problem resumed
slightly adjusts the oblique version of a sans
again after a while.” AOL tech support offered
serif to make up for the angle. In a lowerthe
following advice (which worked):
quality typeface, an oblique may simply be the
1.
Close
down all programs and launch the
slanted version of the roman.
TCP/IP Control Panel.
Tilted type is what you get when you use
the features in your software to slant the type. 2. Click on File on menu bar. Choose
Configuration. Set Active configuration to
The most important point to remember
Default.
Then click on Make Active button.
about true-drawn italic and oblique typeface
3. Top box.... Change connect Via to AOL
is this: very often when you use the keyboard
Link Enhanced.
shortcut or button in your software to make
4. Then change Configure to Using BootP
selected text italic, you are not getting the
true-drawn face – you are getting a tilted face. Server.
5. If the IP Address says Will be supplied by
It is safest to always choose the italic version
server,
then we will move on to the next step.
from your type menu, especially if you will be
6
.
Go
to
Edit menu, select User Mode; switch
sending out the type to a service bureau. 0
to
Advanced,
click OK. In Sub Net Mask box,
Based on an article by Robin Williams

I recently came across a 1989 paper of interest:
“Inventing the LISA Interface,” written by
three ex-Apple employees, describing Apple’s
efforts to create the easy-to-use computer of
the future. This computer was first proposed
in late 1978 by Steve Jobs. Even though
LISA was not a success, you will find that its
interface made the Macintosh look and feel
become the one we know and love. As you
will see, it wasn’t created in a vacuum: it came
from a sharing of information as well as trial
and error – with lofty goals.
For the original paper, refer to www.glue.
umd.edu/~stecher/lisa/00000EBE.html, and
under separate attachment (at the end of the
paper) Pictures of Lisa UI Prototypes, some
initially created on the Apple II. 0

THE LIMAC FORUM/MARCH 2000

Bradley Dichter
bdichter@cdr.net

STUFF!
Donald Hennessy
reports:
“There have been more
problems and delays
with this years’
membership cards
than you could
believe. But don’t fret,
the cards will be
mailed to you.”
The DTP/Photoshop
SIG:
Under the direction
of Richard Scillia
(Creative Abilities),
the SIG examined
ImageReady; learned
when to use .jpeg or
.gif files; and
discussed how to get
“that professional look”
from the many
features of Photoshop.
Members
should bring in
examples of their
work (on a floppy
disk) to show the
group at the next
meeting.
The Mac Help SIG:
Last month’s
demonstration was
replac- ing the
square
alkaline battery in
a Performa 6214CD
and adding one
second memory
module for its
module.

at specified intervals of minutes, hours or
days. All this happens in the background,
unnoticeable to you. In essence, you are
allowed unlimited undos even though your
application denies you the ability. A very
important ability when working in Photoshop,
Illustrator or other programs without
automatic save modes.
I’ve used FlashBack with all my
applications and it really works – even in

QuarkXPress (a perennially unhappy camper
with almost any utility on the Mac). Say you’ve
saved five changes to a file and you decide
you want to return to version three to take
a different direction with your file as well as
keep a copy of what you’ve just done. Simple.
Just drag the previously-saved version you
need out of the FlashBack window or doubleclick it. Flashback quickly builds a complete,
fresh file in that version on the Desktop.

Other niceties in FlashBack include:
| File protection against accidental deletion, file
corruption and a very common form of data loss –
hitting the Save key and overwriting the file.
| Recovering files that have been changed weeks,
or even months before.
| Different versions of the same file can easily be
individually tracked and archived.
So you can sleep well at night knowing
that your Forum is being adequately protected

by FlashBack. 0
FlashBack
Aladdin Systems
$49.95
LIMac members pay only $29.95
Any Mac with 4MB of RAM.
System 7.x or 8.x compatible.
www.aladdinsys.com
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More Technical Corner

TIPS!
Photoshop Layer
Tips:
Fill Holes in a Layer.
Choose Edit > Fill, and
set the Blending menu
to Behind. This will fill
the transparent areas
of a layer.
Select layer objects.
To select everything
that is on the current
layer, Command-click
on the layer’s name
Transform Multiple
Layers.
All the functions under
the Edit > Transform
menu can be applied
to multiple layers by
turning on the link
icon next to each layer.
Group Adjustment
Layer.
If you group an
adjustment layer with
another layer (by
typing Command-G),
the adjustment layer
will only apply to the
layer directly below it
and any other layers
that are part of the
group.
Fill Using Dialog Box.
Type Shift-Delete to
show the Fill box.
View Single Layer.
Option-click the
eyeball icon on any
layer. If only one layer
is currently visible,
Option-click the
eyeball icon of that
layer to display all
layers.
Duplicate to New
Document.
Hold Option when
dragging a layer onto
the new layer icon
at the bottom of the
Layers Palette.

type 255.255.0.0.
7. Save the settings and quit TCP/IP. Restart
the Mac.
| If I find a Preferences file without a
custom icon, does that mean it’s no good?
Not necessarily. The software author may have
not bothered to create a custom icon for the
file type. You may need to run Norton Disk
Doctor and rebuild the Desktop files. If the
creating application is not on the Startup Disk
or partition, it may not give the prefs file a
correct icon. Sometimes a tricky Desktop
rebuild is better done with the aid of the
free TechTool 1.1.9. Of course, you may no
longer have the creating application and then
the Mac OS will consider the file a generic
document, not a document of any particular
program.
| Why would I rebuild my Desktop and
how often should I do it?
I would not do it on a regular basis, only
if I’ve added or removed programs or major
upgrades. Rebuild if you have problems like
double-clicking on a document you created
does not find the creating program or your
documents have either generic of the wrong
icons. You should run Norton Disk Doctor first.
| Toast 3.5.7 and my Yamaha CD recorder
had problems. I was told it conflicted with
my Wacom tablet.
I recommend creating a special set with your
Extensions Manager called CD Record with
most everything off. Leave on Appearance,
Memory, File Exchange, Apple CD-ROM or
Apple CD/DVD Driver, Foreign File Access,
ISO 9660 File Access, High Sierra File Access,
Audio CD File Access, Apple Photo Access,
Toast CD Reader and any Extension needed
for removables like Iomega Driver and any
Extension required for a SCSI card that has
either the recorder or any other source
connected. Also leave on Norton Shared Lib,
so you can run Disk Doctor and Speed Disk.
Any more and you risk having the others
slow down or interrupt the steady flow of
information to your recorder. Also check on
www.versiontracker.com for a firmware update
to version C for the Yamaha 6416 mechanism.
| I’ve been trying to help my PC using
brother by creating some web graphics.
They’re not working out.

You must follow the ground rules. RGB format
at 72 dpi, no layers. Save in JPEG format with
a name ending in .JPG. The name should
have no spaces and no slash “/” characters.
Beyond the ground rules, try to keep the pixel
dimensions and thus the image size and file
size and download time down to a reasonable
level. Not everybody has a large monitor. A
Medium JPEG compression setting will usually
provide acceptable quality.
| I’m new to the Mac. How do I
defragment the Hard Drive.
Buy a copy of Norton Utilities for Macintosh.
Startup the Mac with the CD in and the
“C” key held down. Then run the Norton
Utilities shell program, run Disk Doctor with
the Repair Automatically preference set. Then
switch to Speed Disk, select the Speed Disk 3.2
option and Optimize away. Apple does not
supply a defragmentation solution.
| I recently updated my QuickTime. Now
I get a message at startup that part of my
QuickTime software did not load and needs
updating. I thought I just did that.
I guess it didn’t complete.
Remove all eleven components in the
QuickTime Extensions folder plus the
components loose in the Extensions folder
except the base QuickTime™ Extension and try
the QuickTime Updater program again with
your virus checker off this time. If you’re
running AOL, don’t let its 46-minute warning
get in the way. 0
(Sore Eyes, continued from page 4)

Monday, the light was still blinking.
However, another new repairman arrived!
This young man (they’re all young, of course)
was great. He was completely understanding.
He knew, and told us, the problem. In
December 1999, when we first discussed the
DSL line, our building had the usual copper
telephone lines. Sometime between this date
and the arrival of the first installer, Bell
Atlantic came into the building and replaced
all the telephone lines with fiber optic cables.
DSL does not work with fiber optic cables.
Our wires were finally replaced with copper
wires and we now have DSL service, 6
weeks after they actually started. He even put
back the micro filters the first installer had
removed.. Wow! Stay tuned for Part Three…0
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TIPS!
Illustrator 8 Tips:
A simple keyboard
combination allows
you to select objects
that are hidden under
others. First, switch
to the Selection tool,
or hold down the
Command key, and
click on the top obiect
in the area that the
objects overlap.
Release the mouse.
Now use your
keyboard combination: Command Option - [. Click once
and the top object
deselects and the
object directly below
it selects. Hit your
keyboard combination
again and the object
below that becomes
selected. Now you
have access to every
piece you might need
without the chance of
accidentally moving or
altering them – super
handy for technical
drawing. (You can
also hold the Control
key and click on the
top object, then
choose from the
popup menu. There’s
a big choice.)
Find your Smart Guide
settings (File >
Preferences > Smart
Guides) and
customize your angles.
Illustrator
provides a number of
standard angles that
are preset (90, 45,
30 degrees, etc.), so
you don’t have to type
them in. However, if
you can type 20, 40
and 60 degrees, etc.

Long Island Macintosh Users Group
Post Office Box 518
Seaford, New York 11783
www.limac.org

Digital video is the topic
for the March10 General
Meeting presentation by
Alliance Computer. 7 p.m. at
Anna Rubin Hall (Building
300) at NYIT.
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Helen and
Sheldon Gross
shel9 @ bellatlantic.net
Note: These sites are
referred to by us for
your information only
and neither we nor
LIMac endorse any of
the products or sites.

Sore Eyes

User Group News

Part Two: DSL (Continued from February)
OK. The new modem arrived on the Tuesday
as scheduled. The installer for the new
modem also arrived, on Wednesday, as
scheduled. A bit late, but he did come. The
new modem worked. That is, all the little
lights turned on. Power was green for go.
Link was green, indicating OK. Ready turned
red, as expected and then turned to a flashing
green. Not good. The ready light was winking
and blinking, and winking and blinking. No
synch. The ready light never turned to a
steady green. This is when we discovered that
the communications company, Bell Atlantic,
could not communicate with its employees.
None of the installers had beepers, and
could only use the same telephone numbers
that the general public uses to contact
tech support, listening to the recording
“Your call is important to us”
followed by Vivaldi’s Four Seasons. They also
wait on the same lines for tech assistance.
As the day dragged on, we had 3 different
installers, both upstairs in the apartment, and
downstairs in the basement of the building.
The conclusion: there is a problem in
the CO. (Bell Atlantic Central Office to the
uninitiated) OK. No problem. “Leave the
computer connected and it will be fixed
remotely within 24 hours.”
Next day. Thursday. Green light still
winking and blinking. Calls to the tech help
desk each time require a long wait and
then we start telling the full story to a new
employee each time. Oh no! “We must have
misunderstood. Please wait.”
Friday. We were told that they work
all weekend long. They would fix the CO
problem. (Continued on page 3)

I would like to alert our members to the
following interesting offerings from Apple:
Macintosh User Group Store: The
Macintosh User Group (MUG) Store contains
exclusive offers on Apple factory refurbished
equipment, third-party products and other
merchandise. www.applemugstore. com/.
Login: bluelips. Password: redhips.
Apple Product Tutorials: Detailed
information about new products:
www.apple.com/usergroups/tutorials/. Login:
mugs. Password: tutorials.
Seminars: Over the next several months
Apple will be conducting a series of seminars
on topics of interest to many user group
members. These seminars will be conducted
by Apple Solutions Experts who are
independent consultants and trainers.
Location: Apple Market Center, East 53rd
Street, 29th floor, Citicorp Building, New
York. To register (and for dates and seminar
availability) call 800-895-4853. or
www.seminars.apple.com/series/solutionskit/
index.html. Here are just a few:
| Digital Photography Workflow In High
Production Environments: This seminar will
cover the advantages and the technology
requirements for setting up and designing a
digital photography studio.
| AppleScript Seminar: Learn about
AppleScript and how it can be used to
automate digital workflows and customize
manual
processes.
| A Small Business Intranet Construction
Kit: Build a big-company intranet on a
small-business budget. The solution is
complete with e-mail, websites, calendars and
collaborative workspaces. 0
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TIP!
Deleting “folders
from hell”:
Another method for
deleting folders that
refuse to delete when
you select Empty
Trash (see the
Macintosh Bible on
this topic). If the
Finder refuses to
delete a folder
because it says that
it contains items that
are in use but the
folder is empty: use
StuffIt or DropStuff to
stuff the folder,
making sure to have
its delete originals
after stuffing option
enabled. This deletes
the problem folder.
Then, delete the
archive as well. As this
problem may indicate
Directory damage, you
should also run Disk
First Aid to see if
repairs are needed.

